Matrix maker 2.7 (fat)
TWELVE-TONE MATRIX APPLICATION
ReadMe FILE for using Matrix maker 2.7 (fat) with Microsoft Word 6.x

This folder contains the latest (April, 1996) version of Matrix maker. This program is a
"fat" binary application, containing both 68K and native PowerPC code.

The folder containing this text file includes several items:

1) the Macintosh Matrix maker 2.7 (fat) application, a fat binary application
containing both 68K and PowerPC native code;

2) a SimpleText ReadMae file;

3) a folder labeled "for MSW 5.1 users";

4) a folder labeled "for MSW 6 users" (the folder containing the file that you are
now reading);

5) the Matrix maker 2.7 script AppleScript application

6) a sample output file labeled ‘sample “matrix.txt™’;

7) a sample output file labeled ‘sample “header.txt™’;

8) a sample of the “finished product”, labeled “sample matrix output”.

If you are equipped with Microsoft Word 6.x, set the default font to “Times” (12 points)
—this is not an absolute necessity, but the script is designed with that font and type size
in mind—, open the folder "for MSW 6 users", test the operation of Matrix maker 2.7
(fat) and “Matrix maker 2.7 script” applications, and then (if everything works properly)
drag the folder labeled “for MSW 5.1 users” and its contents, if you so desire, to the
trash. You must have System 7.5 or later installed on your computer in order to use the
AppleScript application (preferably the recent System 7.5.2 Update—also known as
7.5.3), and the “Finder scripting extension” must be in the active “Extensions” folder
within your System Folder. Do not trash the MSW 5.1 folder until you are sure that the
“Matrix maker 2.7 script” AppleScript works correctly with your Word 6.x installation!

If you have reached this line, then I assume that your MSW version is 6.x (i.e., 6.0 or
6.0.1) rather than 5.1. This folder ("for MSW 6 users") contains five items:

1) this ReadMae file;

2-5) four “Document template” files in Microsoft Word 6.x for converting the
output of the Matrix maker 2.7 (fat) application into easily readable form as
12 by 12, 7by 7, 6 by 6, and 5 by 5 matrices.

This application was originally designed (v 1.0) to facilitate the necessary but often
somewhat laborious "busy-work" of constructing 12 by 12 matrices used in the composi-
tion (or analysis) of twelve-tone musical compositions. The application was subsequently
(v 1.1) augmented to allow the creation of matrices of other dimensions than twelve, par-
ticularly those involving five, six, and seven elements. From its inception, the software



package has also allowed the use of the M5 and M7 transforms and rotation as optional
operations. The stationery files included for matrices of five, six, seven, and twelve ele-
ments allow the easy creation of matrices, either with or without pitch-class names,
within the standard grid format. An additional option allows the selection of any pitch-
class name as "0" (zero). Matrix maker 1.2.1 added "hidden text" instructions for pasting
the created data onto each of the (MS Word only) stationery files. Matrix maker 2.0
eliminated some remaining error-detection bugs, provided a more user-friendly interface,
and added the option (for MSW 6.x users) of automating the formatting process by using
an AppleScript application, while still allowing the formatting to be accomplished manu-
ally, as before, for those who either do not have MSW 6.x or whose MSW 6.x applica-
tions stubbornly refuse to work with the script provided (an option dictated by the always
prudent application, whenever computers are involved, of Murphy's Law). Matrix maker
2.5 added a completely automated interface option for Word 6.x users that requires only
that the user double-click on the “Matrix maker 2.7 script” application to initiate the
process, which then continues through the formatting process with no user intervention
except the entering of the data for the set that is to be created. Matrix maker 2.6 created
a larger and much more easily readable application window for the entry of data; this
version also was expanded to allow the use of the program in networked environments in
which the MSW 6.x application is located on a remote server. Matrix maker 2.7 1) elim-
inates some steps that formerly were required before the creation of each matrix; 2) al-
lows the user to create multiple matrices without the necessity of re-launching the pro-
gram; 3) automatically saves the matrix (whenever possible—see below) under a file-
name that is identical with the title of the piece as specified by the user; and 4) offers the
user the option of selecting either automatic saving in the “New matrix folder” that the
application creates on the desktop or asking to be prompted for another name and/or lo-
cation for the newly-created matrix.

Setting up the application for automated and/or manual formatting

Open your Microsoft Word folder (not the application itself) and drag the four “Docu-
ment template” files (“12 x 12 matrix template”, “5 x 5 matrix template”, “6 x 6 matrix
template”, and “7 by 7 matrix template”) to the “Templates” folder within your
Microsoft Word 6.x folder. [See 1) on page 4 for a note concerning a message that will
occur only once upon your first use of the Matrix maker 2.7 script AppleScript applica-
tion.] Do not under any circumstances rename either the folder or any of its compo-
nents, and do not remove either application from the folder or attempt to run the pro-
gram from an alias!

Testing the “Matrix maker 2.7 (fat)” application



It is suggested that you test the Matrix maker 2.7 (fat) application by itself after in-
stalling it and before testing the automated formatting application to make certain that the
application’s output corresponds to that of the sample output files.

To perform this test, double-click on the application file Matrix maker 2.7 (fat) and en-
ter the following information at the prompts. (In this list each prompt line is preceded by
"<" and followed by ">" for your convenience; these symbols do not appear in the
prompts on the screen. You should enter in turn all items not preceded by "<" and fol-
lowed by ">" [these items are printed here in bold type for your convenience].):

<Enter the title of the piece [maximum length = 29 characters; spaces are permissible,
but <no em-dashes or en-dashes, please!], followed by a "%" sign and a carriage return..>
My Incomparable Masterpiece%o

<Enter the set in one-digit integers, separated by commas;>

<for pc numbers 10 and 11, use "t" and "e" respectively.>

3,t,7,6,e,2,9,0,5,4,1,8

<You have asked for a 12 by 12 matrix. Is this correct? Enter y>

<or n.>

y
<Do you want an M5 or M7 transform? Enter y or n.>

y

<Enter the M-transform number.>

7

<Do you want set-rotation? Enter y or n.>

y

<Your set is a full twelve-tone set. Do you want intra-hexachordal>
<rotation? [This type of rotation will preserve the properties of the>
<source hexachord.] If so, enter y.>

<If not, enter n, in which case the rotation>

<will be applied to the set as a whole.>

y

<Enter 2 for 2nd note, 3 for 3rd note, etc. for the desired rotation.>
3

<Do you want pitch-class names to appear under the pc>

<numbers in your matrix? Enter y or n.>

y

<Enter pitch-class name to be used as pitch-class 0 as>
<letter-name--sharps only.>

f#

< (space)>

< (space)>

<The matrix has been successfully created!>

<The matrix output files have been saved in the folder in which this application is lo-
cated.>

< (space)>

<To exit, type <Return>.>



< (space)>

<If you are using Microsoft Word 6.x with the AppleScript “Matrix maker 2.7 script”™
<automated formatting application, the matrix will be formatted with minimal user>
<intervention.>

< (space)>

<Otherwise, format and save it manually according to the instructions in the>
<appropriate "ReadMe" document.>

<Return>

The output file "matrix.txt", should be identical to the sample file ‘sample “matrix.txt”’
provided for comparison; likewise, the output file "header.txt" should match the sample
file ‘sample “header.txt”’. The sample input data listing and output files are designed to
create a 12 by 12 matrix, but other matrices can be created in the same way by following
the instructions on the screen. Remember, if at any time you should wish to abort the
program, simply type <COMMAND><period>, followed by "Quit" from the file menu
(or the shortcut <Command>Q). The file “mtrxsize.txt”, for which a sample file is not
provided, should contain only one number, which should in the case of the sample data
above be “12”; this number always equals the number of elements in your matrix.
NOTE: The name of the composition (the first item requested by the program) may be
edited in the usual way, with backspaces, etc. only before the “%” sign and <CR> are
typed; once these have been entered, further changes are impossible until after the cre-
ation and formatting of the final matrix output file. Note also that the name entered must
contain no more than 29 characters (not including the “%” sign) and may not include any
characters not allowed in standard Macintosh file names.

Creating a fully-formatted matrix automatically

These instructions apply only in the event that you are taking advantage of the fully
automated features of the “Matrix maker 2.7 script” AppleScript application! A set
of simplified instructions is given on pages 10-11 at the end of this file.

1) Double-click on the AppleScript application “Matrix maker 2.7 script”. After the pro-
gram has checked that your system has a Scriptable Finder (you must have System 7.5—
and preferably 7.5.2—in order to use the automated features in this package), a welcome
screen will appear. You will then be asked whether you will be using MSW 6.x, MSW
5.1, or neither. In the latter two cases, which do not concern us here, you will be in-
structed to format the matrix manually. If you indicate that you are using Word 6.x, the
program will then determine whether or not any disk volume other than your startup disk
is mounted on the desktop.



2) If more than one disk is mounted, you will be informed that the application has de-
tected them and you will be presented with three options: a) “Word is active” (signifying
that the Word application is open on a remote server whose icon exists on the desktop);
b) “Word is inactive” (the Word 6 application has not been activated prior to the activa-
tion of the matrix script); or ¢) “No remote server” (regardless of the presence of more
than one disk icon on the desktop, you will not in any case be using a Word application
located anywhere else than on the startup disk). Click the appropriate button (if you are
unsure, click “Word is inactive.”). If you are on a network but you have indicated that
the Word 6 application has not been opened, you will be told that the application must be
active on the server before the Matrix maker 2.7 script application can continue, and you
will be given an opportunity to exit and open Word 6 before re-launching the program. If
you indicate that Word is already active or that no remote server is involved (and if this
information turns out to be correct), the program will proceed as in 4) below.

3) If no other disk shows up on the desktop, the prompts/questions in 2) above will not
appear.

4) You will next be asked whether you wish the matrix or matrices that will be created
should be saved automatically in the “New matrix folder” that will be created on the
desktop under file-names that will correspond to the title(s) of the composition(s) or
whether you wish to be prompted for a name and location after each matrix has been for-
matted.

5) The program will then proceed to create and format your matrix automatically, begin-
ning with step 6). One caveat: Be sure that the option “Confirm conversions” in the dia-
log box that appears when you issue an “Open” command to Word is not checked! If this
box is checked, Word will ask for the type of file conversion every time that it tries to
open a file, which will defeat the entire purpose of the script application! [INOTE: Upon
the occasion of your first use of this script, a dialogue box that asks the question “Where
is Microsoft Word?” will probably appear. This question will occur only upon your in-
stallation or first use of this application; the question refers to the MSW application it-
self, rather than to the folder. If you answer this question incorrectly, strange things for
which I accept no responsibility will happen!]




6) The console window will appear, and you will be issued several prompts. In each
case, after entering the information requested, press <ENTER>. You may exit from the
application at any time by typing <COMMAND><period> followed by
<COMMAND>Q (or by typing just <COMMAND>Q).

a) You will first be prompted to enter the name of the piece for which the matrix
will be used. [WARNING: Do not enter as part of the name either an en-
dash or an em-dash. The script does not know how to handle these and will
interrupt the formatting of the matrix to ask for help! This prohibition also ex-
tends to any other characters not allowable in standard Macintosh file names!
(Such characters may, of course, be added to the title line once the output file
has been created and saved.)] This name must be followed by a “%” sign,
which serves as simply an end-of-data mark and which will not appear in the
subsequent output.

b) You will next be prompted for the set on which you want the matrix to be
based. (These instructions apply to the creation of a 12 by 12 matrix, but they
may be used with some modifications for other matrices as well—see below.)
This set MUST be entered as a series of one-digit numbers from 0 to 11, all
but the last followed by a comma. The numbers "10" and "11" must be repre-
sented by the characters "t" and "e", respectively (whether these characters are
in upper or lower case is irrelevant; this is also the case with all other alpha-
betic characters entered when this application is used). Typing errors will be
flagged, including the entry of duplicate pitch-class numbers and the typing of
more that twelve entries, and an opportunity for re-entry of the set will be
provided. The set entered need not begin on "0" (zero); a set entered as begin-
ning on any other number will automatically be transposed so that the first
note becomes zero. You will be asked if the number of elements in the array
is correct. As in all such prompts, type "y" (yes) or "n" (no).

¢) You will be asked whether or not you wish the set entered to be subjected to an
M5 or M7 transform. Enter "y" or "n", as above. If you entered "n", the pro-
gram will proceed to d) below. If you entered "y", you will be prompted for
the number of the transform, in which case you should enter either 5 or 7. (If
you are not familiar with this relatively recent twelve-tone transformation, en-
ter "'n".)

d) You will be asked whether or not you want rotation. If you entered "n", the
program will proceed to e) below. If you entered "y", you will be asked for
the number of the note within the hexachord or set on which the rotation will
begin (the numbers range from 2 through 6, in the case of hexachords). Obvi-
ously, you could enter "1", but this would result in no rotation at all.

e) You will be asked whether or not you wish pitch-class names to appear below
the numbers. If you enter "n", the window will display the message "The ma-
trix has been successfully created! The matrix output files have been



saved in the folder in which this application is located." (space) "To exit,
type <Return>." (space) "If you are using Microsoft Word 6.x with the
AppleScript “Matrix maker 2.7 script” automated formatting applica-
tion, the matrix will be formatted with minimal user intervention. (space)
Otherwise, format and save it manually according to the instructions in
the appropriate '""ReadMe'" document."

If you enter "y", you will be prompted to enter the pitch-class name (either
single letters from A through G (case irrelevant) or two-character names con-
sisting of one of these letters followed by "#" (no flats, please--there is no flat
character in the font!). [If you enter E# or B#, these letter-names will be au-
tomatically converted to their respective enharmonic equivalents, F-natural
and B-natural.] After you enter this item, the message mentioned earlier in
this paragraph will appear. [If for any reason you have aborted the program
after it has created any of the three text files (“header.txt”, “matrix.txt”, or
“mtrxsize.txt”) but before the automatic formatting takes place, these three (in
some instances, only the first two) files will be found in the “Matrix maker
2.7 folder”. You should probably delete these files before running the pro-
gram again. You must do so if you are running Matrix maker 2.7 (fat) in
stand-alone mode, since if you do not, the program will not execute. How-
ever, if the program is running as a part of the scripted application, any such
files will automatically be deleted before they can cause any trouble.]

Press <Return> to exit the Matrix maker 2.7 (fat) application and to continue with the
formatting process.

The “Matrix maker 2.7 script” will then check to determine the dimensions of your ma-
trix. Please note that this application is designed to handle only 12 by 12, 7 by 7, 6 by
6, and 5 by 5 matrices; an output file that indicates a matrix of any other size will
cause the program to terminate execution. After creating and formatting your matrix,
the program (unless you have specified otherwise in 4) above) will automatically save it
in a new desktop folder called “New matrix folder” as a Word 6.x file under a file-name
that corresponds to the name of the composition that you entered previously and will put
the three output files produced by the Matrix maker 2.7 (fat) application (“matrix.txt”,
“header.txt”, and “mtrxsize.txt”) in the Trash. If the “New matrix folder” already exists
on the desktop, if you do not requested to be prompted for a file-name and location for
saving, and if a file called by the same name has either deliberately or accidentally been
left in that folder, you will be informed that the file will be saved in the folder as the
specified file-name followed by “/” and a number (from 2 through 9) that will be incre-
mented by 1 for each succeeding identically-named file (the program is not designed to
number these files by any number of more than one digit). In no case will an existing
“matrix output” file be over-written by a new one.

Following the successful creation of each matrix, you will be offered the choice of either
quitting or creating additional matrices. In the latter case, the program will begin again



with step 6) above, thus avoiding the necessity of re-opening Word 6.x; this feature, new
with this version, greatly increases the ease of using the application in a networked envi-
ronment if multiple matrices are to be created.

Upon quitting, the program is designed to leave the deleted items in the “Trash rather
than emptying the “Trash” to avoid wiping out other files that the user may have placed
there but not definitely decided to trash permanently; therefore, there will always be sev-
eral (sometimes a great many) items in the “Trash” following the creation of each matrix.
However, before quitting, the program will ask whether or not the user wishes to empty
the “Trash” (the default button is “No”).



If you cannot get the “Matrix maker 2.7 script” to work

Creating the matrix data manually

The instructions in this section and the following section (“Processing the output
file”) apply only in the event that you are not using the fully-automated capabilities
of the “Matrix maker 2.7 script” AppleScript application!

To use the Matrix maker 2.7 (fat) application in stand-alone mode, perform the follow-
ing steps to create a 12 by 12 matrix:

1) Double-click on the “Matrix maker 2.7 (fat)” icon.

2) The console window will appear, and you will be issued several prompts. In each
case, after entering the information requested, press <ENTER>. You may exit
from the application at any time by typing <COMMAND><period> followed by
<COMMAND>Q (or by typing just <COMMAND>Q).

a) You will first be prompted to enter the name of the piece for which the matrix
will be used. [WARNING: Do not enter as part of the name either an en-
dash or an em-dash. The script does not know how to handle these and will
interrupt the formatting of the matrix to ask for help! This prohibition also ex-
tends to any other characters not allowable in standard Macintosh file names!
(Such characters may, of course, be added to the title line once the output file
has been created and saved.)] This name must be followed by a “%” sign,
which serves as simply an end-of-data mark and which will not appear in the
subsequent output.

b) You will next be prompted for the set on which you want the matrix to be
based. (These instructions apply to the creation of a 12 by 12 matrix, but they
may be used with some modifications for other matrices as well—see below.)
This set MUST be entered as a series of one-digit numbers from 0 to 11, all
but the last followed by a comma. The numbers "10" and "11" must be repre-
sented by the characters "t" and "e", respectively (whether these characters are
in upper or lower case is irrelevant; this is also the case with all other alpha-
betic characters entered when this application is used). Typing errors will be
flagged, including the entry of duplicate pitch-class numbers and the typing of
more that twelve entries, and an opportunity for re-entry of the set will be
provided. The set entered need not begin on "0" (zero); a set entered as begin-
ning on any other number will automatically be transposed so that the first
note becomes zero. You will be asked if the number of elements in the array
is correct. As in all such prompts, type "y" (yes) or "n" (no).

¢) You will be asked whether or not you wish the set entered to be subjected to an
M5 or M7 transform. Enter "y" or "n", as above. If you entered "n", the pro-



ne,n

gram will proceed to d) below. If you entered "y", you will be prompted for
the number of the transform, in which case you should enter either 5 or 7. (If
you are not familiar with this relatively recent twelve-tone transformation, en-
ter "'n".)

d) You will be asked whether or not you want rotation. If you entered "n", the
program will proceed to e) below. If you entered "y", you will be asked for
the number of the note within the hexachord or set on which the rotation will
begin (the numbers range from 2 through 6, in the case of hexachords). Obvi-
ously, you could enter "1", but this would result in no rotation at all.

e) You will be asked whether or not you wish pitch-class names to appear below

the numbers. If you enter "n", the window will display the message "The ma-
trix has been successfully created! The matrix output files have been
saved in the folder in which this application is located." (space) "To exit,
type <Return>." (space) "If you are using Microsoft Word 6.x with the
AppleScript “Matrix maker 2.7 script” automated formatting applica-
tion, the matrix will be formatted with minimal user intervention. (space)
Otherwise, format and save it manually according to the instructions in
the appropriate '""ReadMe" document."
If you enter "y", you will be prompted to enter the pitch-class name (either
single letters from A through G (case irrelevant) or two-character names con-
sisting of one of these letters followed by "#" (no flats, please--there is no flat
character in the font!). [If you enter E# or B#, these letter-names will be auto-
matically converted to their respective enharmonic equivalents, F-natural and
B-natural.] After you enter this item, the message mentioned earlier in this
paragraph will appear. If for any reason you have aborted the program after
it has created any of the three text files (“header.txt”, “matrix.txt”, or
“mtrxsize.txt”) but before the automatic formatting takes place, these three
(in some instances, only the first two) files will be found in the “Matrix
maker 2.7 folder”. You must delete these files before running the program
again. If you do not do so, the application will refuse to run!!

If you are using Microsoft Word 6.x and you cannot get the AppleScript "Matrix maker
2.7 script” to work with your Word installation, then either save the MSW 5.1 stationery
files provided in the folder “for MSW 5.1 users” as MSW 6.x “Document templates” and
drag them to the “Templates” folder within your Microsoft Word 6.x folder or drag the
templates provided for that purpose in the “for MSW 6 users” folder to the Word 6.x
“Templates” folder. Then open a “New” file from the “File” menu (you must use the
“File” menu, since simply typing <Command>N will not prompt you for a template),
select the appropriate template, open the document “matrix.txt”, choose “Select All”
from the “Edit” menu, select “Convert text to table” from the “Table” menu, select
“Copy” from the “Edit” menu when the text-to-table conversion is complete, and proceed
to paste onto the “new” file (which will probably be called “DocumentN”, where “N” is
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some number) by double-clicking anywhere within the grid while holding down the
<Option> key, using the "Paste special" command from the "Edit" menu and selecting
"Unformatted text" in the dialogue box (this is very important!). If you have saved the
MSW 5.1 stationery files as templates as outlined above, “hidden text” will appear, ex-
actly as in the original MSW 5.1 stationery files; this text will not print unless your Word
application is configured to print hidden characters. In case you forget the procedure to
be used, it is very convenient to be able to refer to the hidden text that appears above the
grid for instructions about how to proceed. (You may find it necessary, when the matrix
is completed, to nudge the number in the upper left-hand corner one or two spaces to the
right to line it up with the others.)

Next, open and copy, as above, the contents of the file "header.txt" and paste the line(s)
at the top of the matrix grid document, centering the line(s) and making font changes if
desired.

All that remains is to name and save the file in the usual fashion, as a normal Word Doc-
ument.

(It 1s also possible to leave the stationery files in their original format, since in this case
they will function just as do such files in MSW 5.1; however, since Word 6.x is set up
somewhat differently than Word 5.1, it makes sense to use templates instead. The choice
is up to the user.)

Differences between v 2.7 and v 2,6
Substantial differences exist between v 2.7 and earlier versions:

1) the option of creating multiple matrices without re-initializing the program has been
added;

2) an additional option now exists that allows the user to specify either a) automatic sav-
ing of each new matrix in a folder created for that purpose on the desktop or b) prompt-
ing for a file-name and/or location for each new matrix;

3) the saving (if requested under 2a) above) of each matrix under a file-name that corre-
sponds to the composition’s title as entered by the user has been added; and

4) some annoying bookkeeping dialogues during the first stages of the program’s execu-
tion have been eliminated.

5) The AppleScript “Matrix formatter 2.6 script” that was a part of v 2.6 has also been
done away with, since it seemed to most users to be superfluous.

Differences between v 2.6 and v 2.5
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Matrix maker 2.6 created a larger and much more easily readable application window
for the entry of data than was present in earlier versions. This version was also expanded
to allow the use of the program in networked environments in which the MSW 6.x appli-
cation is located on a remote server.

Differences between v 2.5 and v 2.0

Matrix maker 2.5 represented a major improvement over v 2.0 for those equipped with
Microsoft Word 6.x. In this version, the option of creating the matrix automatically from
start to finish, with the only user intervention occurring during the initial entering of the
data used to create the set itself, was added. The other options already present in v 2.0,
however, namely either semi-automatic or manual formatting, were retained, making the
program adaptable to many different circumstances, depending upon the word-processing
application available to the user. The requirement for a minor user intervention at the end
of the process to prevent the saving of a useless file was eliminated.

Differences between v 2.0 and v 1.2.1

The differences between v 2.0 and earlier versions were significant. Some remaining
bugs were ironed out, and a much more user-friendly interface was added. The principal
change, however, was the addition of an AppleScript application that can automatically
copy, format, and save a completed matrix with almost no user intervention, provided
that the user has an active installation of Microsoft Word 6.x on his/her system. Since the
use of the script application may not work in all cases, however, the option of formatting
the matrix manually, as in earlier versions, was retained. Folders for use with both MSW
5.1 and MSW 6.x were included, each with pertinent documentation.

Differences between v 1.2.1 and 1.2

The principal change in this version was the addition of the "hidden text" in the sta-
tionery files. Version 1.2.1 also contained some significant fixes regarding bugs in error-
detection that managed to slip by in v 1.2.

Differences between v 1.2 and 1.1

This version was the first "fat" binary version, containing both Macintosh 68K (68020
and above) and native PowerPC code. The code for both types of processor was opti-
mized to run more quickly and efficiently than in previous versions. Improved error-de-
tection for typing errors in the entry of data not present in earlier versions was included
in v 1.2. Additional word-processing template files for matrix layout were provided. The
option of selecting either intra-hexachordal or entire-set rotation for full twelve-tone sets
was also added (v 1.1 allowed only intra-hexachordal rotation). The other principal dif-
ference was a fix of a minor but potentially annoying bug involving creator types.
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Differences between v 1.1 and 1.0

The differences between v 1.1 and v 1.0 were minimal. The code was optimized some-
what, and it became unnecessary to adjust the column width in the Microsoft Word text-
to-table conversion prior to pasting the table onto the appropriate stationery file.

Simplified guide to the use of the
“Matrix maker 2.7 script” for automated formatting
of matrices created with “Matrix maker 2.7 (fat)”

1) Double-click on the Matrix maker 2.7 script AppleScript application icon.

2) When asked for the type of word-processing application being used, click the button
labeled Microsoft Word 6.x.

3) If more than one disk is mounted on your desktop, follow the instructions in the
prompts as the program attempts to determine whether or not you are working in
a network environment, and if so, whether your Word 6.x application is active on
the remote server. If no disk other than your startup disk appears on the desktop,
these prompts will not appear; in this case, you will go directly from step 2)
above to step 4) below.

4) Follow the instructions in the next to specify whether you wish the matrices to be
saved automatically or you want to be prompted for a file-name and/or location
for each matrix.

5) Follow the directions given by the prompts to enter your matrix data.

6) If you have made the correct choices and if nothing is wrong with the matrix data
computed earlier, your matrix will be formatted and saved with no further inter-
ruptions. You will be notified when the process is complete; when this occurs,
click OK .

7) You will be asked if you would like to quit or if you want to create another matrix; in
the latter case, the program returns to step 5) above.

8) If you select “Quit” at the prompt in step 7) above, you will be asked before the pro-
gram quits whether or not you want to empty the “Trash”, which will contain
some work files placed there by this program (the default button is “No”), after
which execution will terminate.

Known bugs, incompatibilities, etc.

I have so far encountered no problems with running this package on a properly config-
ured system. Such a system contains the following:
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a) System 7.5 or later (7.5.2—a.k.a. 7.5.3—is preferred)

b) The “Finder scripting extension” within the active “Extensions” folder

¢) Microsoft Word v 6.0 or 6.0.1 with the option “Confirm conversions”
unchecked in the “Open” menu.

As mentioned earlier, the “Matrix maker 2.7 folder” must not be renamed; if it is, the
program will not execute. 1t should also be noted that the “Matrix maker 2.7 script”
should always remain within its proper place within the folder. It will generally not exe-
cute properly when placed elsewhere, and it will not execute properly when activated
from an alias!

Occasionally, and for no apparent reason, the AppleScript routine may unexpectedly quit.
When this happens, you will see a flashing exclamation point in the “Finder” position on
the main menu bar. If this appears, pull down the menu until the script application is
highlighted, quit the application, and try again. This problem usually disappears upon re-
running the application. If it does not, the problem may be due to one of the following
reasons:

1) The system may be improperly configured (see above); most often, the cause
of the trouble is that the “Finder scripting extension” is inactive. Also, be sure
that you do indeed have System 7.5 or later.

2) You may be using either a version of Microsoft Word other than v 6.0 or 6.0.1
or another word-processing program entirely. This package works automati-
cally only with some version of Microsoft Word 6! 1f this is the case, refer to
the section in the folder “for MSW 5.1 users” and to the documentation for
your word-processing application for some hints concerning manual format-
ting of the matrix data.

4) A system on which Word 6.x executes very slowly (this includes many if not
most Macintoshes prior to the introduction of the Power Macintosh) may run
at such a speed that AppleScript thinks that execution has stopped, even if it is
going on at an extremely slow rate. AppleScript is configured to “time out”
after a certain amount of time if nothing seems to be happening. While this is
unlikely with Matrix maker 2.7, it is certainly not beyond the realm of possi-
bility.

If the program stops to ask for the desired type of file conversion upon opening the text
files created by Matrix maker 2.7 (fat), then the “Confirm conversions” option in the

“Open” menu is probably checked. Uncheck it and begin again.

If all else seems to fail, refer to the instructions about formatting the matrix manually.
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The Matrix maker 2.7 (fat) application itself (without the AppleScript routines) should
(in theory, at least) run on systems earlier than 7.5. However, bear in mind that this is a
supposition on my part that is not supported by personal experience.

This application is freeware, with no strings attached except that the application and re-
lated files may not be sold or otherwise commercially exploited (though it may, of
course, be used by composers and/or analysts—after all, that's why it was written!). This
package may be freely distributed, provided that all of its contents remain unaltered and
that acknowledgment of the authorship of the program is given. For information, com-
ments, etc., send me an e-mail message at either "j-melby@uiuc.edu" or "jbmel-
by@net66.com". Enjoy!

John Melby

Professor of Music

University of Illinois at Urbana-Champaign
April 14, 1996

© Copyright 1996 by John Melby
All rights reserved
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